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 ABSTRACT 

Bachelor’s degree in  04.03.01 -  Chemistry.  

Study profile: Fundamental chemistry. 

Course title: Computer simulation of the properties of chemical compounds. 

Modular discipline, 3 credits. 

Instructor: Maxim E. Zhidkov, PhD. 

At the beginning of the course a student should be able to have the following 

preliminary competences: 

 ability to use the acquired knowledge of theoretical bases of fundamental 

chemistry during professional activities; 

  possession of skills in chemical experiment, the main synthetic and 

analytical methods of production and investigation of chemical substances and 

reactions; 

  ability to use the basic laws of natural sciences in professional activities; 

  ability to perform common operations of the proposed methods; 

  knowledge of fundamental chemical concepts; 

  ability to apply basic laws of natural science and the laws of development 

of the chemical sciences in the analysis of the results; 

 possession of methods for the safe handling of chemical materials, taking 

into account their physical and chemical properties. 

Learning outcomes: After studying of the discipline the students are formed 

the following general (GC) / general professional (GPC)/ specific professional 

competences (SPC). 

SPC-5: the ability to receive and process the results of scientific experiments 

using modern computer technology; 

GPC-4: the ability to communicate orally and in writing in Russian and 

foreign languages to meet the challenges of professional activity. 

Course description:  

Course description: The goal of the study of this discipline is to form 

students' professional competencies in the field of modeling of the biological 

activity of the studied compounds. The task of this discipline are: 

 to generate basic knowledge about the principles and algorithms of 

computer modeling of the interaction of small molecules with therapeutic targets, 

facilitating the optimization of biologically active substances, as well as to assess 



the contribution of individual structural fragments of molecules in the formation of 

their biological activities.  

 

Main course literature:  

1. Computational Pharmaceutics: Application of Molecular Modeling in Drug 

Delivery / D. Ouyang, et al. – New York : John Wiley & Sons, 2015.- 340 p. 

http://eu.wiley.com/WileyCDA/WileyTitle/productCd1118573994,subjectC

d-CHD0.html     

http://eu.wiley.com/WileyCDA/WileyTitle/productCd1118573994,subjectCd-CHD0.html
http://eu.wiley.com/WileyCDA/WileyTitle/productCd1118573994,subjectCd-CHD0.html


АННОТАЦИЯ 

Дисциплина «Компьютерное моделирование свойств химических 

соединений» разработана для студентов 3-го курса по направлению 

подготовки 04.03.01 «Химия» профиль «Фундаментальная химия»в 

соответствие с образовательным стандартом, самостоятельно 

устанавливаемым ДВФУ, утвержденного приказом ректора от 18.02.2016 

№12-13-235. 

Дисциплина «Компьютерное моделирование свойств химических 

соединений» входит в Дисциплины блока Б1.Б.12 учебного плана ОПОП. В 

рамках данной дисциплины рассматриваются основные методы 

молекулярного моделирования для предсказания биологической активности 

органических соединений. Данный курс неразрывно связан со следующими 

дисциплинами направления подготовки бакалавров 04.03.01 «Химия»: 

«Математика», «Органическая химия», «Химические основы биологических 

процессов», «Основные классы природных соединений», «Механизмы 

реакций и стереохимия», «Методы выделения и установления строения 

органических молекул». 

Общая трудоемкость освоения дисциплины составляет три зачетные 

единицы, 108 часов. Учебным планом предусмотрены контролируемая 

самостоятельная работа (27 часов), самостоятельная работа студента (81 час). 

Дисциплина реализуется на _3_ курсе в _5 и 6_ семестрах. 

Цель изучения данной дисциплины заключается в формировании у 

обучающихся профессиональных компетенций в области моделирования 

биологической активности исследуемых соединений. 

Задачи: Сформировать фундаментальные знания о принципах и 

алгоритмах компьютерного моделирования взаимодействия 

низкомолекулярных соединений с терапевтическими мишенями, 

облегчающего оптимизацию БАВ, а также позволяющие оценить вклад 

отдельных структурных фрагментов молекулы в формирование ее 

биологической активности. Для успешного изучения дисциплины «Основы 

компьютерного моделирования» у обучающихся должны быть 

сформированы следующие предварительные компетенции: 

 способностью использовать полученные знания теоретических основ 

фундаментальных разделов химии при решении профессиональных задач. 

 Способностью использовать основные законы естественнонаучных 

дисциплин в профессиональной деятельности. 

 владением системой фундаментальных химических понятий. 

 способностью применять основные естественнонаучные законы и 

закономерности развития химической науки при анализе полученных 

результатов. 



В результате изучения данной дисциплины у обучающихся 

формируются следующие общекультурные/ общепрофессиональные/ 

профессиональные компетенции (элементы компетенций). 

Код и формулировка 

компетенции 

Этапы формирования компетенции 

ПК-5 -  

способностью 

получать и 

обрабатывать 

результаты научных 

экспериментов с 

помощью 

современных 

компьютерных 

технологий 

Знает 

- математические основы современных методов 

моделирования строения низкомолекулярных 

соединений, терапевтических мишеней и 

молекулярного докинга 

Умеет 

-применять основные методы моделирования 

строения низкомолекулярных соединений, 

терапевтических мишеней и молекулярного 

докинга 

Владеет 
- методологией прогнозирования биологической 

активности исследуемых соединений 

ОПК-4 - готовность 

к коммуникации в 

устной и письменной 

формах на русском и 

иностранном языках 

для решения задач 

профессиональной 

деятельности 

Знает 

-широкий набор профессиональных терминов, 

используемых при описании структуры 

терапевтической мишени и проведении 

молекулярного докинга 

Умеет 

-применять специальную терминологию в рамках 

взаимодействия с другими обучаемыми и 

преподавателем 

Владеет 

- навыком самостоятельной подготовки научных 

текстов и докладов в области компьютерного 

моделирования молекул и изучения зависимости 

структура-активность 



 

I. СТРУКТУРА И СОДЕРЖАНИЕ ТЕОРЕТИЧЕСКОЙ ЧАСТИ КУРСА  

- не предусмотрена учебным планом 

 

II. СТРУКТУРА И СОДЕРЖАНИЕ ПРАКТИЧЕСКОЙ ЧАСТИ 

КУРСА 

- не предусмотрена учебным планом 

 

III. СТРУКТУРА И СОДЕРЖАНИЕ КОНТРОЛИРУЕМОЙ 

САМОСТОЯТЕЛЬНОЙ РАБОТЫ 

Раздел 1. Молекулярная механика (4 час.) 

Содержание: Определение молекулярной механики (ММ) как способа 

описания объектов микромира законами классической физики. Функции, 

применяемые для выражения длин связей, валентных углов, торсионных 

напряжений, электрических явлений и сил Ван-дер-Ваальса. Силовые поля. 

Минимизация модели, метод градиентного спуска и метод Ньютона.  

Раздел 2. Молекулярная динамика (5 час.) 

Содержание: Определение молекулярной динамики (МД) как способа 

моделирования поведения системы частиц – материальных точек. Учет 

влияния внутренних сил, действующих на частицы. Оценка взаимодействия 

со средой, температура и термостаты. Второй закон Ньютона в 

дифференциальной форме и методы численного интегрирования.  

Раздел 3. Моделирования взаимодействия рецептор-лиганд (10 час.) 

Содержание: Получение пространственной структуры рецептора. 

Основные виды взаимодействий между лигандом и терапевтической 

мишенью и их моделирование.  

Раздел 4. Современные алгоритмы поиска экстремума нелинейных 

функций нескольких переменных (8 час.) 

Содержание: Статистические методы минимизации (метод Монте-

Карло, «simulated annealing»). Методы направленного поиска глобального 

минимума (генетический алгоритм, метод постепенного конструирования, 

табу-поиск).  

 

IV. УЧЕБНО-МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

САМОСТОЯТЕЛЬНОЙ РАБОТЫ ОБУЧАЮЩИХСЯ 

 



Учебно-методическое обеспечение самостоятельной работы 

обучающихся по дисциплине «Компьютерное  моделирование свойств 

химических соединений» представлено в Приложении 1 и включает в себя: 

план-график выполнения самостоятельной работы по дисциплине, в том 

числе примерные нормы времени на выполнение по каждому заданию; 

характеристика заданий для самостоятельной работы обучающихся и 

методические рекомендации по их выполнению; 

требования к представлению и оформлению результатов 

самостоятельной работы; 

критерии оценки выполнения самостоятельной работы. 

 

V. КОНТРОЛЬ ДОСТИЖЕНИЯ ЦЕЛЕЙ КУРСА 

 

№ 

п/п 

Контролир

уемые 

разделы / 

темы 

дисциплин

ы 

Коды и этапы формирования компетенций  Оценочные средства  

текущий 

контроль 

промежуточн

ая аттестация 

2 Раздел I. 

Молекуляр

ное 

моделиров

ание и 

докинг 

ПК-5 знает теоретические основы 

молекулярного докинга 

 -Устный опрос 

студентов 

 

умеет  

1) определять целевую 

терапевтическую мишень для 

исследуемых соединений,  

2) проводить молекулярный 

докинг исследуемых соединений с 

терапевтической мишенью 

Реферат (ПР-4).   

владеет навыком оптимизации 

структуры соединений методом 

молекулярного докинга 

Отчет о 

результатах 

исследований 

(ПР-9) 

 

ОПК

-4 

знает широкий набор 

профессиональных терминов, 

используемых при описании 

структуры терапевтической 

мишени, проведении 

молекулярного докинга 

Реферат(ПР-4) 

и Отчет о 

собственных 

исследованиях 

(ПР-9) 

 

умеет применять специальную 

терминологию в рамках 

взаимодействия с другими 

обучаемыми и преподавателем 

Реферат(ПР-4) 

и Отчет о 

собственных 

исследованиях 

(ПР-9 

 

владеет навыком самостоятельной 

подготовки научных текстов и 

докладов в области 

Отчет о 

собственных 

исследованиях 

- 



компьютерного моделирования 

молекул 

(ПР-9) 

 

Типовые задания для самопроверки, методические материалы, 

определяющие процедуры оценивания знаний, умений и навыков и (или) 

опыта деятельности, а также критерии и показатели, необходимые для 

оценки знаний, умений, навыков и характеризующие этапы формирования 

компетенций в процессе освоения образовательной программы, 

представлены в Приложении 2. 

 

VI. СПИСОК УЧЕБНОЙ ЛИТЕРАТУРЫ И ИНФОРМАЦИОННО-

МЕТОДИЧЕСКОЕ ОБЕСПЕЧЕНИЕ ДИСЦИПЛИНЫ 

 

Основная литература 

(электронные и печатные издания) 

 

1. Computational Pharmaceutics: Application of Molecular Modeling in Drug 

Delivery / D. Ouyang, et al. – New York : John Wiley & Sons, 2015.- 340 p. 

http://eu.wiley.com/WileyCDA/WileyTitle/productCd-1118573994,subjectCd-

CHD0.html    

Дополнительная литература 

(печатные и электронные издания) 

 

1. Molecular Diversity and Combinatorial Chemistry Principles and 

Applications / M. Pirrung – Amsterdam : Elsevier, 2004.- 188 p. 

http://store.elsevier.com/product.jsp?isbn=9780080444932  

2. Neural Computing: Theory and Practice / Ph. D. Wasserman – New York : 

Van Nostrand Reinhold Company, 1989.- 230 p. http://pdf-

esmanual.com/48746.html  

 

Перечень ресурсов информационно-телекоммуникационной сети 

«Интернет» 

http://eu.wiley.com/WileyCDA/WileyTitle/productCd-1118573994,subjectCd-CHD0.html
http://eu.wiley.com/WileyCDA/WileyTitle/productCd-1118573994,subjectCd-CHD0.html
http://store.elsevier.com/product.jsp?isbn=9780080444932
http://pdf-esmanual.com/48746.html
http://pdf-esmanual.com/48746.html


1. QSAR World [Web source] / Developer : Strand Life Sciences. – Access 

mode: http://www.strandls.com/sarchitect/index.html, free. – the title on the 

screen 

2.  Software for molecular modeling [Web source] / Developer : Agile 

Molecule. – Access mode: http://www.biomolecular-modeling.com/ , free. – 

the title on the screen 

3.  VEGA ZZ Molecular Modeling Toolkit [Web source] / Developer : Drug 

Design Laboratory. – Access mode: http://www.vegazz.net/, free. – the title 

on the screen 

Перечень информационных технологий  

и программного обеспечения 

Для проведения Практических занятий в рамках курса используется 

специальное программное обеспечение Vega ZZ, Autodock Vina, Autodock 4 и 

MGL Tools актуальных версий. 

 

VII. МЕТОДИЧЕСКИЕ УКАЗАНИЯ ПО ОСВОЕНИЮ 

ДИСЦИПЛИНЫ 

 

Освоение данной дисциплины включает три этапа: 1) проведение 

аналитического обзора литературы с целью определения терапевтической 

мишени для молекулярного докинга исследуемых соединений; 2) освоение 

теоретической базы используемой методологии; 3) проведение 

самостоятельных исследований по оптимизации структуры исследуемого 

соединения. 

 

А) Подготовка аналитического обзора литературы с целью 

определения терапевтической мишени для молекулярного докинга 

На начальном этапе студент должен по данным обзора литературы, 

посвященной исследуемому им соединению, сделать вывод, имеются ли 

сведения о проявлении им биологической активности. В большинстве 

случаев имеющиеся сведения касаются изучения общих аспектов 

биологического действия соединения, например, его способности подавлять 

рост микроорганизмов без привязки к конкретному механизму действия или 

http://www.strandls.com/sarchitect/index.html
http://www.biomolecular-modeling.com/
http://www.vegazz.net/


терапевтической мишени. Данная ситуация эквивалентна полному 

отсутствию сведений о биологической активности исследуемого соединения 

и определяет необходимость привлечения баз данных, индексирующие 

биологические свойства соединений и оснащенные алгоритмами подбора 

близких структур, основанных на молекулярных графах или иных методиках. 

К таким ресурсам относятся программы PASS и Reaxys. После анализа 

полученных результатов или опираясь на уже известные данные необходимо 

изучить доступность кристаллических структур для выявленных рецепторов 

во всемирном банке данных PDB. После обобщения найденной информации 

необходимо выбрать наиболее перспективную целевую терапевтическую 

мишень для проведения докинга. 

Б) Освоение теоретической базы используемой методологии  

На данном этапе студентам предстоит самостоятельно изучить 

теоретические основы методологии компьютерного моделирования и 

молекулярного докинга по предоставленным материалам (лекции и 

рекомендованная литература) и далее самостоятельно выполнить несколько 

работ на закрепление навыка применения данных методов для оценки 

биологической активности соединений. 

В) Проведение самостоятельных исследований по оптимизации 

структуры исследуемого соединения 

На первом этапе исследований необходимо скачать с сайта всемирного 

банке данных PDB файл, содержащий кристаллическую структуру 

выбранной терапевтической мишени. После подготовки полученной 

структуры рабочую модель можно использовать для проведения докинга. 

Далее необходимо осуществить докинг исследуемого соединения с 

терапевтической мишенью. В полученном расчетном комплексе необходимо 

проанализировать молекулярные контакты в программе Autodock Tools. На 

основании анализа молекулярных контактов и синтетических возможностей 

по введению в базовую структуру различных заместителей, сконструировать 

серию производных и аналогов исследуемого соединения. Провести докинг с 

набором полученных моделей. Проанализировать результаты и выбрать 

наиболее перспективные соединения для дальнейших исследований. 

VIII. МАТЕРИАЛЬНО-ТЕХНИЧЕСКОЕ ОБЕСПЕЧЕНИЕ 

ДИСЦИПЛИНЫ 

Для проведения работ по изучению биологической активности с 

использованием методов компьютерного моделирования необходимо 



наличие персональных компьютеров (ноутбуков), оснащенных 

современными двухядерными процессорами с объемом оперативной памяти 

не менее 4 Гб, а также доступа к скоростному каналу доступа в сеть Internet. 
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План-график выполнения самостоятельной работы по дисциплине 

№ 

п/п 

Дата/сроки 

выполнения 

Вид 

самостоятельной 

работы 

Примерные 

нормы 

времени на 

выполнение 

Форма контроля 

1 9 недель 5 

семестра 

Аналитический 

обзор литературы 

для определения 

целевой 

терапевтической 

мишени 

27 часов Защита реферата 

преподавателю 

1 1 неделя 6 

семестра 

Изучение 

материалов по теме 

«Молекулярная 

механика». 

4 часа Устный опрос 

2 3 неделя 6 

семестра 

Изучение 

материалов по теме 

«Молекулярная 

динамика». 

5 часов Устный опрос 

4 5 неделя 6 

семестра 

Изучение 

материалов по теме 

«Моделирования 

взаимодействия 

рецептор-лиганд» 

5 часов Устный опрос 

5 7 неделя 6 

семестра 

Изучение 

материалов по теме 

«Современные 

алгоритмы поиска 

экстремума 

нелинейных 

функций нескольких 

переменных» 

4 часа Устный опрос 

7 9-18 недели 6 

семестра 

Проведение 

самостоятельных 

исследований по 

оптимизации 

структуры 

исследуемого 

соединения 

36 часов Сдача отчета о 

результатах 

собственных 

исследований 

 



Характеристика заданий для самостоятельной работы обучающихся и 

методические рекомендации по их выполнению 

А) Аналитический обзор литературы для определения целевой 

терапевтической мишени для докинга 

На начальном этапе студент должен исходя из данных обзора 

литературы, посвященной исследуемому им соединению, сделать вывод, 

имеются ли сведения о проявлении им биологической активности. В 

большинстве случаев имеющиеся сведения касаются изучения общих 

аспектов биологического действия соединения, например, его способности 

подавлять рост микроорганизмов без привязки к конкретному механизму 

действия или терапевтической мишени. Данная ситуация фактически 

эквивалентна полному отсутствию сведений о биологической активности 

исследуемого соединения и определяет необходимость привлечения баз 

данных, индексирующие биологические свойства соединений и оснащенные 

алгоритмами подбора близких структур, основанных на молекулярных 

графах или иных методиках. К таким ресурсам относятся программы PASS и 

Reaxys. После анализа полученных результатов или опираясь на уже 

известные данные необходимо изучить доступность кристаллических 

структур для выявленных рецепторов во всемирном банке данных PDB. 

После обобщения найденной информации необходимо выбрать наиболее 

перспективную целевую терапевтическую мишень для проведения докинга. 

Б) Проведение самостоятельных исследований по оптимизации 

структуры исследуемого соединения 

На первом этапе исследований необходимо скачать с сайта всемирного 

банке данных PDB файл, содержащий кристаллическую структуру 

выбранной терапевтической мишени. После подготовки полученной 

структуры рабочую модель можно использовать для проведения докинга. 

Далее необходимо осуществить докинг исследуемого соединения с 

терапевтической мишенью. В полученном расчетном комплексе необходимо 

проанализировать молекулярные контакты в программе Autodock Tools. На 

основании анализа молекулярных контактов и синтетических возможностей 

по введению в базовую структуру различных заместителей, сконструировать 

серию производных и аналогов исследуемого соединения. Провести докинг с 

набором полученных моделей. Проанализировать результаты и выбрать 

наиболее перспективные соединения для дальнейших исследований. 



Требования к представлению и оформлению результатов 

самостоятельной работы 

А) Реферат 

Реферат и Отчет о результатах собственных исследований 

оформляются по правилам оформления письменных работ студентами 

ДВФУ
1
. Работы представляются в печатной или электронной форме, 

подготовленные как текстовые документы в редакторе MS Word. 

Структурно работа оформляется по следующей схеме: 

 Титульный лист – обязательная компонента, первая страница 

(титульный лист должен размещаться в общем файле, где представлен текст 

работы); 

 Основная часть – материалы выполнения заданий, разбивается по 

рубрикам, соответствующих заданиям работы, с иерархической структурой: 

пункты – подпункты и т. д.  

Рекомендуется в основной части заголовки рубрик (подрубрик) давать 

исходя из формулировок заданий, в форме отглагольных существительных; 

 Выводы – обязательная компонента реферата, содержит 

обобщающие выводы по работе; 

 Список литературы – обязательная компонента реферата, с новой 

страницы, содержит список источников, использованных при выполнении 

работы, включая электронные источники (список нумерованный, в 

соответствии с правилами описания библиографии). 

Набор текста осуществляется на компьютере, в соответствии со 

следующими требованиями: 

 печать – на одной стороне листа белой бумаги формата А4 (размер 

210 на 297 мм.); 

 интервал межстрочный – полуторный; 

 шрифт – Times New Roman; 

                                                 
1
 Требования к оформлению письменных работ, выполняемых студентами Института химии и прикладной 

экологии ДВГУ / В. А. Реутов. – Владивосток: Изд-во Дальневост. ун-та, 2010. – 59 с. 



 размер шрифта - 14 пт., в том числе в заголовках (в таблицах 

допускается 10-12 пт.); 

 выравнивание текста – «по ширине»; 

 поля страницы - левое – 25-30 мм, правое – 10 мм, верхнее и нижнее 

– 20 мм; 

 нумерация страниц – в правом нижнем углу страницы (для страниц с 

книжной ориентацией), сквозная, от титульного листа до последней 

страницы, арабскими цифрами (первой страницей считается титульный 

лист, на котором номер не ставиться, на следующей странице 

проставляется цифра «2» и т. д.).  

 режим автоматического переноса слов, за исключением титульного 

листа и заголовков всех уровней (перенос слов для отдельного абзаца 

блокируется средствами MSWord с помощью команды «Формат» – 

абзац при выборе опции «запретить автоматический перенос слов»). 

 Результаты докинга исследуемых соединений должны быть 

представлены в виде таблицы и подтверждены иллюстрациями, 

отражающими строение расчетных комплексов. 

 В разделе Экспериментальная часть должна быть представлена 

методика проведения докинга, при этом итоговые файлы в формате 

pdbqt и dlg должны быть сохранены и представлены с электронной 

версией работы. 

Если рисунок или таблица размещены на листе формата больше А4, их 

следует учитывать как одну страницу. Номер страницы в этих случаях 

допускается не проставлять.  

Список литературы и все приложения включаются в общую в сквозную 

нумерацию страниц работы. 

 

Критерии оценки выполнения самостоятельной работы 

Реферат  



Зачтено с характеристикой отлично выставляется обучаемому, если 

студент на основании аналитического обзора литературы самостоятельно 

осуществил обоснованный выбор теоретической мишени (или предложил 

несколько равнозначных мишеней) для проведения докинга с исследуемым 

соединением путем сопоставления знаний о практической значимости 

рассмотренных рецепторов для создания новых лекарственных препаратов, 

наличием для них данных рентгеноструктурного анализа в базе данных PDB 

и возможности их применения для проведения докинга, степени схожести 

исследуемого соединения с известными лигандами данных рецепторов. 

Фактических ошибок и замечаний к оформлению работы нет или они 

несущественны. 

Зачтено с характеристикой хорошо выставляется обучаемому, если 

студент осуществил поиск и систематизацию литературных данных о 

биологической активности исследуемого вещества и родственных ему 

соединений, однако не смог без помощи преподавателя осуществить выбор 

терапевтической мишени для дальнейших исследований. Студент знает и 

умеет пользоваться современными базами данных для поиска литературы, 

однако не владеет в достаточной степени методами и приемами анализа 

результатов теоретических исследований, в частности не способен 

сопоставить степень структурной близости исследуемого соединения с 

лигандами рассматриваемых рецепторов. Фактических ошибок нет. 

Допущены одна-две ошибки в оформлении работы. 

Зачтено с характеристикой удовлетворительно выставляется 

обучаемому, если студент осуществил поиск необходимой литературы, но 

предоставил полностью переписанный исходный текст публикации без 

комментариев и анализа по рассматриваемой тематике. Студент умеет 

пользоваться современными базами данных, прочитал найденный материал, 

но не понял его содержание. Работа оформлена небрежно: допущено более 

трех существенных ошибок в ее оформлении. 

Не зачтено выставляется обучаемому, если студент предоставил 

литературу, не относящуюся к рассматриваемому предмету, предоставил 

полностью переписанный исходный текст публикации без комментариев и 

анализа по рассматриваемой тематике. Студент не умеет пользоваться 

современными базами данных, не изучил и не ориентируется в 

предоставленном материале. Работа оформлена крайне небрежно: допущено 

более пяти существенных ошибок в ее оформлении. 

Отчет о результатах собственных исследований 



Зачтено с характеристикой отлично выставляется обучаемому, если 

студент, опираясь на предоставленные «Методические указания», 

самостоятельно осуществил моделирование серии производных и аналогов 

исследуемого соединения, докинг полученных моделей с выбранной 

терапевтической мишенью и сделал аргументированный выбор наиболее 

перспективных соединений для непосредственного получения, 

продемонстрировав тем самым владение навыком самостоятельной 

исследовательской работы; методами и приемами анализа теоретических и 

практических аспектов молекулярного докинга. Фактических ошибок и 

замечаний к оформлению работы нет или они несущественны. 

Зачтено с характеристикой хорошо выставляется обучаемому, если 

студент с минимальным привлечением преподавателя осуществил 

моделирование серии производных и аналогов исследуемого соединения, 

докинг полученных моделей с выбранной терапевтической мишенью, но не 

смог без помощи преподавателя сделать аргументированный выбор наиболее 

перспективных соединений для непосредственного получения. Допущены 

одна-две ошибки в оформлении отчета. 

Зачтено с характеристикой удовлетворительно выставляется 

обучаемому, если студент осуществил моделирование серии производных и 

аналогов исследуемого соединения и докинг полученных моделей с 

выбранной терапевтической мишенью исключительно с помощью 

преподавателя, а также не смог сделать аргументированный выбор наиболее 

перспективных соединений для непосредственного получения. Работа 

оформлена небрежно: допущено более трех существенных ошибок в ее 

оформлении.  

Не зачтено выставляется обучаемому, если студент не смог построить 

модель исследуемого соединения и серии его производных и аналогов; не 

предоставил результаты докинга полученных моделей с выбранной 

терапевтической мишенью, а также не смог сделать аргументированный 

выбор наиболее перспективных соединений для непосредственного 

получения. Работа оформлена крайне небрежно: допущено более пяти 

существенных ошибок в ее оформлении.  
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Паспорт  

Фонда оценочных средств  

по дисциплине «Основы компьютерного моделирования» 

Код и формулировка 

компетенции 

Этапы формирования компетенции 

ПК-5 -  

способностью 

получать и 

обрабатывать 

результаты научных 

экспериментов с 

помощью 

современных 

компьютерных 

технологий 

Знает 

-основные математические основы современных 

методов моделирования строения 

низкомолекулярных соединений, терапевтических 

мишеней и молекулярного докинга 

Умеет 

-применять основные методы моделирования 

строения низкомолекулярных соединений, 

терапевтических мишеней и молекулярного 

докинга 

Владеет 
- методологией прогнозирования биологической 

активности исследуемых соединений 

ОПК-4 - готовность 

к коммуникации в 

устной и письменной 

формах на русском и 

иностранном языках 

для решения задач 

профессиональной 

деятельности 

Знает 

-широкий набор профессиональных терминов, 

используемых при описании структуры 

терапевтической мишени и проведении 

молекулярного докинга 

Умеет 

-применять специальную терминологию в рамках 

взаимодействия с другими обучаемыми и 

преподавателем 

Владеет 

- навыком самостоятельной подготовки научных 

текстов и докладов в области компьютерного 

моделирования молекул и изучения зависимости 

структура-активность 



 

№ 

п/п 

Контролир

уемые 

разделы / 

темы 

дисциплин

ы 

Коды и этапы формирования компетенций  Оценочные средства  

текущий 

контроль 

промежуточн

ая аттестация 

2 Раздел I. 

Молекуляр

ное 

моделиров

ание и 

докинг 

ПК-5 знает теоретические основы 

молекулярного докинга 

 -Устный опрос 

студентов 

 

умеет  

1) определять целевую 

терапевтическую мишень для 

исследуемых соединений,  

2) проводить молекулярный 

докинг исследуемых соединений с 

терапевтической мишенью 

Реферат (ПР-4).  - 

владеет навыком оптимизации 

структуры соединений методом 

молекулярного докинга 

Отчет о 

результатах 

исследований 

(ПР-9) 

- 

ОПК

-4 

знает широкий набор 

профессиональных терминов, 

используемых при описании 

структуры терапевтической 

мишени, проведении 

молекулярного докинга 

Реферат(ПР-4) 

и Отчет о 

собственных 

исследованиях 

(ПР-9) 

 

умеет применять специальную 

терминологию в рамках 

взаимодействия с другими 

обучаемыми и преподавателем 

Реферат(ПР-4) 

и Отчет о 

собственных 

исследованиях 

(ПР-9 

 

владеет навыком самостоятельной 

подготовки научных текстов и 

докладов в области 

компьютерного моделирования 

молекул 

Отчет о 

собственных 

исследованиях 

(ПР-9) 

- 

Шкала оценивания уровня сформированности компетенций 

Код и 

формулировка 

компетенции 

Этапы формирования 

компетенции 

критерии показатели 

ПК-5 -  

способностью 

получать и 

обрабатывать 

результаты 

научных 

Знает 

(порог

овый 

уровен

ь) 

-основные 

математические 

основы 

современных 

методов 

моделирования 

строения 

Знание 

фундаментальны

х основ методов 

компьютерного 

моделирования 

Оценка знаний 

теоретических основ 

молекулярного докинга  



экспериментов с 

помощью 

современных 

компьютерных 

технологий 

низкомолекулярных 

соединений, 

терапевтических 

мишеней и 

молекулярного 

докинга 

Умеет 

(продв

инуты

й) 

-применять 

основные методы 

моделирования 

строения 

низкомолекулярных 

соединений, 

терапевтических 

мишеней и 

молекулярного 

докинга 

Умение на 

практике 

применить 

теоретические 

знания 

фундаментальны

х основ 

компьютерного 

моделирования 

Оценивается умение 

определять 

терапевтическую 

мишень выбранного 

соединения, проводить 

молекулярный докинг 

исследуемых 

соединений 

Владее

т 

(высок

ий) 

- навыком 

оптимизации 

структуры 

исследуемого 

соединения с 

использованием 

направленных 

методов увеличения 

сродства к 

терапевтической 

мишени 

Владение 

навыком 

оптимизации 

структуры 

исследуемого 

соединения с 

использованием 

направленных 

методов 

увеличения 

сродства к 

терапевтической 

мишени 

Оцениваются 

результаты 

оптимизации 

структуры 

исследуемого 

соединения с точки 

зрения правильности 

выбора рецептора, 

качества проведения 

докинга и анализа его 

результатов 

ОПК-4 - готовность 

к коммуникации в 

устной и 

письменной формах 

на русском и 

иностранном 

языках для решения 

задач 

профессиональной 

деятельности 

Знает 

(порог

овый 

уровен

ь) 

широкий набор 

профессиональных 

терминов, 

используемых при 

описании структуры 

терапевтической 

мишени, 

проведении 

молекулярного 

докинга  

Знание 

широкого набора 

профессиональн

ых терминов, 

используемых 

при описании 

структуры 

терапевтической 

мишени, 

проведении 

молекулярного 

докинга  

Оценивается уровень 

знаний 

профессиональных 

терминов, 

используемых при 

описании структуры 

рецептора, проведении 

молекулярного докинга  

Умеет 

(продв

инуты

й) 

- применять 

специальную 

терминологию в 

рамках 

взаимодействия с 

другими 

обучаемыми и 

преподавателем 

Умение 

применять 

специальную 

терминологию  

Оценивается умение 

применять 

специальную 

терминологию в рамках 

взаимодействия с 

другими обучаемыми и 

преподавателем 

Владее

т 

(высок

ий) 

 - навыком 

самостоятельной 

подготовки научных 

текстов и докладов 

в области 

компьютерного 

Владение 

навыком 

самостоятельной 

подготовки 

научных текстов 

Оценивается владение 

навыком подготовки 

научных текстов и 

докладов в области 

компьютерного 



моделирования 

молекул 
и докладов моделирования 

молекул 

 

Методических рекомендаций, определяющих процедуры оценивания 

результатов освоения дисциплины «Компьютерное моделирование 

свойств химических соединений» 

Оценочные средства для промежуточной аттестации студентов.  

Промежуточная аттестация студентов по дисциплине «Компьютерное 

моделирование свойств химических соединений» проводится в соответствии 

с локальными нормативными актами ДВФУ и является обязательной. 

Промежуточная аттестация по дисциплине «Компьютерное моделирование 

свойств химических соединений» проводится в форме зачета и включает 

защиту реферата с аналитическим обзором литературы по биологической 

активности исследуемых соединений (5 семестр) и защиту отчета по 

результатам собственных исследований (6 семестр).  

Критерии оценки выполнения самостоятельной работы 

Реферат  

Зачтено с характеристикой отлично выставляется обучаемому, если 

студент на основании аналитического обзора литературы самостоятельно 

осуществил обоснованный выбор теоретической мишени (или предложил 

несколько равнозначных мишеней) для проведения докинга с исследуемым 

соединением путем сопоставления знаний о практической значимости 

рассмотренных рецепторов для создания новых лекарственных препаратов, 

наличием для них данных рентгеноструктурного анализа в базе данных PDB 

и возможности их применения для проведения докинга, степени схожести 

исследуемого соединения с известными лигандами данных рецепторов. 

Фактических ошибок и замечаний к оформлению работы нет или они 

несущественны. 

Зачтено с характеристикой хорошо выставляется обучаемому, если 

студент осуществил поиск и систематизацию литературных данных о 

биологической активности исследуемого вещества и родственных ему 

соединений, однако не смог без помощи преподавателя осуществить выбор 

терапевтической мишени для дальнейших исследований. Студент знает и 

умеет пользоваться современными базами данных для поиска литературы, 



однако не владеет в достаточной степени методами и приемами анализа 

результатов теоретических исследований, в частности не способен 

сопоставить степень структурной близости исследуемого соединения с 

лигандами рассматриваемых рецепторов. Фактических ошибок нет. 

Допущены одна-две ошибки в оформлении работы. 

Зачтено с характеристикой удовлетворительно выставляется 

обучаемому, если студент осуществил поиск необходимой литературы, но 

предоставил полностью переписанный исходный текст публикации без 

комментариев и анализа по рассматриваемой тематике. Студент умеет 

пользоваться современными базами данных, прочитал найденный материал, 

но не понял его содержание. Работа оформлена небрежно: допущено более 

трех существенных ошибок в ее оформлении. 

Не зачтено выставляется обучаемому, если студент предоставил 

литературу, не относящуюся к рассматриваемому предмету, предоставил 

полностью переписанный исходный текст публикации без комментариев и 

анализа по рассматриваемой тематике. Студент не умеет пользоваться 

современными базами данных, не изучил и не ориентируется в 

предоставленном материале. Работа оформлена крайне небрежно: допущено 

более пяти существенных ошибок в ее оформлении. 

Отчет о результатах собственных исследований 

Зачтено с характеристикой отлично выставляется обучаемому, если 

студент, опираясь на методические указания из Практической части курса, 

самостоятельно осуществил моделирование серии производных и аналогов 

исследуемого соединения, докинг полученных моделей с выбранной 

терапевтической мишенью и сделал аргументированный выбор наиболее 

перспективных соединений для непосредственного получения, 

продемонстрировав тем самым владение навыком самостоятельной 

исследовательской работы; методами и приемами анализа теоретических и 

практических аспектов молекулярного докинга. Фактических ошибок и 

замечаний к оформлению работы нет или они несущественны. 

Зачтено с характеристикой хорошо выставляется обучаемому, если 

студент с минимальным привлечением преподавателя осуществил 

моделирование серии производных и аналогов исследуемого соединения, 

докинг полученных моделей с выбранной терапевтической мишенью, но не 

смог без помощи преподавателя сделать аргументированный выбор наиболее 



перспективных соединений для непосредственного получения. Допущены 

одна-две ошибки в оформлении отчета. 

Зачтено с характеристикой удовлетворительно выставляется 

обучаемому, если студент осуществил моделирование серии производных и 

аналогов исследуемого соединения и докинг полученных моделей с 

выбранной терапевтической мишенью исключительно с помощью 

преподавателя, а также не смог сделать аргументированный выбор наиболее 

перспективных соединений для непосредственного получения. Работа 

оформлена небрежно: допущено более трех существенных ошибок в ее 

оформлении.  

Не зачтено выставляется обучаемому, если студент не смог построить 

модель исследуемого соединения и серии его производных и аналогов; не 

предоставил результаты докинга полученных моделей с выбранной 

терапевтической мишенью, а также не смог сделать аргументированный 

выбор наиболее перспективных соединений для непосредственного 

получения. Работа оформлена крайне небрежно: допущено более пяти 

существенных ошибок в ее оформлении.  

 

Оценочные средства для текущей аттестации 

Текущая аттестация студентов по дисциплине «Компьютерное 

моделирование свойств химических соединений» проводится в соответствии 

с локальными нормативными актами ДВФУ и является обязательной. 

Объектами оценивания выступают: 

 - учебная дисциплина, при этом оцениваются активность на 

контролируемой самостоятельной работе;  

- степень усвоения теоретических знаний;  

- уровень овладения практическими умениями и навыками по всем 

видам учебной работы.  

Оценивание учебной дисциплины проводится путем заполнения 

преподавателем календарного журнала посещений, сдачи допусков и 

отчетов. Степень усвоения теоретических знаний определяется по 

результатам сдачи допусков к контролируемой самостоятельной работе, а 

уровень использования практических умений и навыков оценивается 

качеством выполнения практических работ и ведения отчетов. Контроль 



результатов самостоятельной работы студентов достигается комплексным 

применением всех обозначенных выше оценочных средств. 

Комплект вопросов для самопроверки по дисциплине «Компьютерное 

моделирование свойств химических соединений» 

(наименование дисциплины) 

1. Физические основы взаимодействия рецептор-лиганд и их 

моделирование (силы Ван-дер-Ваальса, электростатическое взаимодействие, 

образование водородных связей, гидрофобные взаимодействия). 

2. Моделирование строения рецептора и лиганда (методы 

молекулярной механики, основные квантово-механические методы расчёта 

строения молекул органических соединений). 

3. Методы докинга 1: геометрический докинг, статистические 

методы (метод Монте-Карло, «simulated annealing»). 

4. Методы докинга 2: методы направленного поиска глобального 

минимума функции (метод градиентного спуска, генетический алгоритм). 

Критерии степени освоения материала: 

Отличное освоение материала имеет место, если студент глубоко и прочно 

усвоил материал, исчерпывающе, последовательно, четко и логически 

стройно его излагает; в ходе дополнительных вопросов не затрудняется с 

ответом, свободно характеризует результаты собственных исследований в 

области расчета биологической активности исследуемого соединения, 

демонстрируя владение разносторонними навыками и приемами выполнения 

практических задач в рассматриваемой области. 

Критерием владения материалом на хорошо является то, что студент твердо 

знает материал, грамотно и по существу излагает его, не допуская 

существенных неточностей в ответе на вопрос, способен соотнести 

обсуждаемые теоретические положения с проведенными лабораторными 

работами, но в ходе дополнительных вопросов путается и затрудняется с 

ответом. В результатах собственных исследований ориентируется с трудом. 

Удовлетворительное владение материалом выявляется, если студент имеет 

знания только основного материала, но не усвоил его деталей, допускает 

неточности, недостаточно правильные формулировки, нарушения логической 



последовательности в изложении материала, не способен соотнести 

обсуждаемые теоретические положения с проведенными лабораторными 

работами. 

Критериями неудовлетворительного освоения материала является незнание 

студентом значительной части материала, при этом имеют место 

существенные ошибки. Выставляется студентам, которые не освоили 

практическую часть курса и (или) не выполнили предусмотренную планом 

самостоятельную работу. 

 

Комплект заданий для контролируемой самостоятельной работы по 

дисциплине «Компьютерное моделирование свойств химических 

соединений» (Описание процедуры выполнения заданий приведено в 

Приложении 3) 

Самостоятельная работа № 1. Построение модели лиганда. 

Самостоятельная работа №2. Занятие 1: Получение 

пространственной структуры терапевтической мишени исследуемого 

соединения.  

Самостоятельная работа № 2. Занятие 2: Оптимизация структуры 

терапевтической мишени методом молекулярной динамики. 

Самостоятельная работа № 3. Расчет сетки атомных 

чувствительных потенциалов. 

Самостоятельная работа № 4. Проведение молекулярного докинга. 

 

Критерии оценки (складывается из трех составляющих: устного 

опроса знаний теоретических основ используемых методов, проведения 

экспериментальной работы и качества отчета): 

Оценка отлично выставляется студенту, если обучаемый в ходе устной 

беседы с преподавателем продемонстрировал 1) знание последовательности 

и содержания экспериментальных операций, которые предстоит выполнить в 

ходе практического занятия, 2) понимание назначения каждой операции в 

рамках реализуемого метода, 3) глубокое понимание физико-химических 

процессов (механизмов), протекающих при выполнении каждой операции. 

Экспериментальная работа была выполнена в соответствии с методическими 

указаниями, с высоким уровнем самостоятельности. Отчет оформлен без 



ошибок, содержит основные разделы, представленные в Требованиях к 

оформлению, эксперимент описан грамотно, приведены все необходимые 

расчеты и сделан обоснованный вывод. 

Оценка хорошо выставляется студенту, если обучаемый в ходе устной 

беседы с преподавателем продемонстрировал знание последовательности и 

содержания экспериментальных операций, которые предстоит выполнить в 

ходе практического занятия, а также понимание назначения каждой операции 

в рамках реализуемого метода. Экспериментальная работа была выполнена в 

соответствии с методическими указаниями. Отчет оформлен с 

незначительными ошибками, содержит основные разделы, представленные в 

Требованиях к оформлению, описание эксперимента выполнено с 

недостатками, но позволяет его воспроизведение, расчеты приведены не 

полностью, но сделан обоснованный вывод. 

Оценка удовлетворительно выставляется студенту, если обучаемый в 

ходе устной беседы с преподавателем продемонстрировал только знание 

последовательности и содержания экспериментальных операций, которые 

предстоит выполнить в ходе практического занятия. Экспериментальная 

работа была выполнена неаккуратно, был нарушен порядок проведения 

эксперимента, что потребовало его переделки, при этом основные правила 

техники безопасности были соблюдены. Отчет содержит значительные 

ошибки, некоторые из необходимых разделов отсутствуют, описание 

эксперимента выполнено с недостатками, но позволяет его воспроизведение, 

расчеты приведены не полностью, вывод сформулирован недостаточно 

точно. 

Оценка неудовлетворительно выставляется студенту в случае, если он 

не получил допуск для выполнения работы; в ходе проведения 

экспериментальной работы были существенно нарушены методические 

указания; не был предоставлен отчет по проделанной работе. 



Приложение 3 

 

Методические указания для проведения Практических занятий в рамках 

курса «Основы компьютерного моделирования»  

 

На первом этапе необходимо проверить, имеется ли структура целевого рецептора во 

всемирной базе кристаллических структур белков. Для этого необходимо выйти на 

официальный сайт базы www.rcsb.org/pdb/home/home.do и в окне поиска (верхний правый 

угол) ввести название интересующего нас белка. После этого необходимо тщательно 

изучить результаты поиска и, если будет найдена устраивающая во всех отношениях 

структура, скачать её pdb-код или скачать саму структуру в специальном формате .pdb 

(кнопка над изображением модели). 

В нашем случае нас интересует структура фермента циклинзависимой киназы 2, 

играющая ключевую роль в регуляции клеточного цикла и являющая терапевтической 

мишенью некоторых противоопухолевых лекарственных препаратов. Ее PDB код - 1HCK. 

Файл PDB необходимо сохранить в отдельной папке, локализованной в папке с 

программой VEGA ZZ и названной латинскими буквами. 

1. Запустите программу Vega ZZ (выбрать Мой компьютер -> Съемный диск-> 

Vega ZZ.exe. Щелкните на виджет Vega ZZ в левом верхнем углу и в 

раскрывшемся списке выберите Vega ZZ. В окне программы откройте 

сохраненный файл с рецептором (File->Open ). 

2. Нормализуйте координаты полученной структуры с целью поместить ее в 

начало координат Edit -> Coordinates -> Normalize, внимательно 

рассмотрите полученную молекулу (приближение колесиком мыши, 

вращение – перемещение мыши при зажатой левой кнопке). 

При внимательном рассмотрении полученной структуры можно заметить, что она 

представляет собой комплекс нативного фермента с АТФ в активном сайте. Однако из-за 

близости межатомных расстояний компьютер представляет этот комплекс как единую 

структуру. Эту ошибку нужно исправить вручную, разорвав две связи, связывающие 

белок и АТФ. 

3. В меню Edit выберите Remove->Bonds. Затем левой кнопкой мыши 

последовательно щелкните на два атома, связанные «лишней» связью, после 

этого связь будет удалена. После завершения правки выйдете из меню, 

нажав Done. 

Кристаллизационная вода не нужна и может создать проблемы при докинге, поскольку ее 

положение фиксировано и не может быть изменено в ходе докинга. 

4. Чтобы удалить кристаллизационную воду, выберите Edit -> 

Remove -> Water. 

5. Добавите к полученной модели атомы водорода (Edit -> Add -> Hydrogens), 

выбрав Protein в Molecule type, Residue end в Position of hydrogens и 

http://www.rcsb.org/pdb/home/home.do
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поставите галочку Use IUPAC atom nomenclature. Нажмите Add для 

добавления атомов водорода. 

6. Определите тип атомов и частичные заряды на них (Calculate -> Charge & 

Pot.), выбрав в Force field CHARMМ и Gasteiger в Charges. Нажмите кнопку 

Fix. 

7. Сохраните молекулу (File -> Save As) по именем 1HCK. Используйте 

формат IFF/RIFF, поскольку он позволяет сохранить максимальное 

количество информации о молекуле (тип атома, частичный заряд и т.д.). 

Оптимизация структуры терапевтической мишени методом молекулярной 

динамики 

1. Выберите все атомы (View -> Select -> All). 

2. В главном меню выберите Edit -> Coordinates -> Constraints and выберите 

Fix в меню Mode and Protein backbone в меню Selection. Нажмите кнопку 

Apply. Фиксированные атомы (the backbone) будут окрашены в синий цвет, а 

конформационно подвижные атомы в зеленый. Закройте окно Constraint 

options. 

3. Откройте диалоговое окно NAMD (Calculate -> NAMD), выберите Other tab 

и в меню Presettings, дважды кликните на Min - Atom fixed, чтобы загрузить 

настройки, необходимые для выполнения минимизации энергии с 

фиксированными атомами. 

4. Переключитесь на вкладку Basic и выберите Number of timesteps в меню 

Timestep parameters 10000. 

5. В вкладке Input напротив Force field выставите CHARMM22_PROT. 

6. Нажмите кнопку Run. При появлении предупреждающих окон нажмите 

кнопку Ok. 

7. После завершения расчетов сохраните полученную структуру как 1HCK 

_min.iff. Откройте предыдущую модель рецептора 1HCK.iff и сравните ее с 

оптимизированной структурой. 

Расчет сетки атомных чувствительных потенциалов 

С целью проведения докинга в ходе которого лиганд помещается в полость активного 

центра данного фермента, необходимо выбрать все атомы в радиусе 10 ангстрем вокруг 

активного. 

1. Откройте файл оптимизированной модели рецептора 1HCK _min.iff. 
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2. Найдите все молекулы в комплексе, выбрав Edit -> Molecules -> Fix. Три молекулы 

будут найдены. 

3. Выберите молекулу АТФ (View -> Select -> Molecule), щелкнув по ней и нажав 

кнопку Select. Лиганд будет выделен. 

4. Откройте Atom selection window (View -> Select -> Custom) и выберите вкладку 

Proximity . В меню What , выберите Atoms, во вкладке the Around, выберите 

Molecule кликните на атом выбранной молекулы на рабочем поле. Введите 15 в 

Radius field и, наконец, нажмите на кнопку +. Все атомы внутри сферы радиусом 15 

Å вокруг лиганда будут выделены. 

5. Удалите лиганд: выберите Edit -> Remove -> Molecule, выберите молекулу лиганда 

и нажмите кнопку Remove. 

6. Конвертируйте полученный файл в формат PDBQT, необходимый для проведения 

докинга. File ->Run script -> AutoDock. Раскрыть вкладку, выбрать Receptor.c, Run. 

В отрывшемся окне выбрать наберите имя сохраняемого файла 1HCK.pdbqt. Когда 

появиться вопрос Do you want run AutoGrid, подтвердите и дождитесь окончания 

расчетов. 

Построение модели лиганда 

1. В основном окне программы Vega ZZ выберите Edit->ISIS Draw (SketchEl). 

2. В открывшемся окне постройте структуру низкомолекулярного лиганда из 

числа предложенных. 

3. Конвертируйте полученную структуру в Vega ZZ (Vega ZZ-> Send to Vega 

ZZ). 

4. Добавьте к полученной модели атомы водорода (Edit -> Add -> Hydrogens), 

выбрав General organic в Molecule type, After each heave atom в Position of 

hydrogens box и выберите Use the bond order to assign the atom types. 

Нажмите Add для добавления атомов водорода. 

5. Для минимизации молекулы методом молекулярной механики определите 

тип атомов и частичные заряды на них (Calculate -> Charge & Pot.), выбрав в 

Force field MM+ и Gasteiger в Charges. Нажмите кнопку Fix. Затем выберите 

Calculate -> Ammp-> minimization. 

или 

Для минимизации полуэмпирическими методами квантовой механики 

выберите Calculate ->Mopac-> AM1. 

6. Полученную модель сохраните в формате xyz.IFF или xyz.mol2. 

7. Конвертируйте полученный файл в формат PDBQT, необходимый для 
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проведения докинга. File ->Run script -> AutoDock. Раскройте вкладку, 

выберите Ligand.c, В отрывшемся окне наберите имя сохраняемого файла 

xyz. pdbqt. Нажмите Run. 

Проведение молекулярного докинга  

1. Запустите консоль программы VEGA ZZ (Щелкните на виджет Vega ZZ в 

левом верхнем углу и в раскрывшемся списке выберите VEGA console). 

2. В окне консоли перейдите в рабочую папку с моделями рецептора и лиганда с 

помощью команды cd (cd X:\VEGA ZZ\xxx, где ххх-название вашей папки). 

3. Вручную наберите команду gridock -t score.dpf 1HCK.pdbqt xxx.pdbqt, где 

ххх- название файла лиганда. 

Примечание: параметр –t определяет метод проведения расчетов, если ввести –

t[XXX. dpf], где ХХХ-название метода докинга, можно изменять алгоритм докинга 

(например, генетический или Монте -Карло), а редактируя шаблон метода в 

Блокноте, можно подобрать параметры в рамках выбранного метода. Шаблоны 

докинга находятся в папке VEGA ZZ\Data\AutoDock. 

Нажмите Enter. После завершения расчетов в рабочей папке откройте текстовый 

файл с расширением .log  Вы увидите результат расчета в следующем виде:  

10:31:39 INIT: GriDock 1.0.0.20 started on Windows 

10:31:39 INIT: Local time Mon, 02 Feb 2009 11:31:39 

10:31:39 INIT: Cpu model: AMD Opteron(tm) Processor 250 

10:31:39 INIT: CPUs/Cores detected: 2 

10:31:39 INIT: CPUs/Cores used: 1 

10:31:39 INIT: AutoDock/VEGA directory: "D:\Documenti\Lcc\Vega" 

10:31:39 INIT: AutoDock executable: "D:\Documenti\Lcc\Vega\AutoDock4.exe" 

10:31:39 INIT: VEGA executable: "D:\Documenti\Lcc\Vega\Vega.exe" 

10:31:39 INIT: Receptor file: "1HPV.pdbqt" 

10:31:39 INIT: Database file: "Ligand.pdbqt" 

10:31:39 INIT: AutoDock template file: "score.dpf" 

10:31:39 INIT: AutoDock output archive: "1HPV-Ligand_01.zip" 

10:31:39 INIT: Max. size of AutoDock output archive: 4000000000 bytes 

10:31:39 INIT: Energy output file: "1HPV-Ligand.csv" 

10:31:39 INIT: Temporary file directory: "C:\DOCUME~1\ALESSA~1\IMPOST~1\Temp" 

10:31:39 INIT: First molecule to dock: 1 

10:31:39 INIT: Input database in PDBQT format: one molecule only will be 

docked 

10:31:39 INIT: AMMP time-out: 120 sec. 

10:31:39 INIT: AutoDock time-out: 12000 sec. 

10:31:39 INIT: VEGA time-out: 120 sec. 

10:31:39 INFO: Starting AutoDock - Molecule 1 (Ligand) 

10:31:41 INFO: Molecule 1 - Docking finished (0m 2s) 

10:31:41 DOCK: Molecule 1 - Best model 1, Best Binding energy = -8.29 

kcal/mol, Ki = 838.53 uM 

10:31:41 INFO: End of calculation 

10:31:41 INFO: Docked molecules 1 

10:31:41 INFO: Elapsed time 0h 0m 2s 

 


